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proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related
documentation, is provided for use only in accordance with the terms of the license agreement.
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Using RiskBook for Risk Register Collaboration

Using RiskBook for Risk Register Collaboration

When you create risk events in Acumen, you may want others to review them and to provide
input about the risk levels and impacts. You now have the option to publish your risk register and
risk scoring matrix to RiskBook; an Acumen Add-on that uses Kona's cloud-based social
collaboration and productivity features.

When you publish a risk register to RiskBook, Kona creates a space for that risk register. A new
space is created for each risk register that you publish to RiskBook. All the risks that were in the
risk register are published to the Kona space and can be viewed on the Risks tab. You can click
on a risk and see a complete risk breakdown, including the values that the risk register owner
entered for probability, as well as schedule and cost impacts.

As the owner of the Kona space, you can invite people to the space to add comments and to
share their opinions about the risks. For example, you may have listed a very high risk probability
whereas others may feel the probability is a medium risk.

In addition, you can use the other Kona tabs, such as the Conversations and Tasks tabs, to
discuss the risks and to add tasks for others to complete. For example, you may add a task
requiring each person in the space to add their own scores to the risk items.

As with other Kona spaces, you have the option to set up space templates. For example, you
may want to create a template that includes standard tasks relating to risk register. When you
publish to RiskBook, you can select the template which Kona then uses when creating the space.

After everyone has provided feedback, you can export the risk register to an XML file format
which can then be imported back into Acumen. You can then compare your original risk register
with the collaborative version and make any needed adjustments.

E The Acumen RiskBook license includes a Kona Business Account.

RiskBook
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Software Requirements

Software Requirements

In order to use RiskBook, you will need a RiskBook license and one of the following browsers:
= Internet Explorer 9 or higher
= Google Chrome version 12 or higher
= Safari 6.0 or higher
=  Firefox 9 or higher
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The Kona Business Token

The Kona Business Token

The Kona Business Token includes three fields (Redirect URL, Client ID, and Client Secret)
and is used to link Acumen to Kona. You will need this information if you need to manually enable
RiskBook in Acumen (see next topic).

@ You must be a Kona Business Account Administrator in order to obtain the Kona Business
0 Token.

To obtain the Kona Business Token, complete the following steps:
From Kona, click Accounts in the left sidebar.

Click the Account name.

Click Edit Account in the upper right portion of the screen.
Click the Integrations tab.

If Acumen is listed, skip to step 8, otherwise continue with step 6.

o g A~ w DN PE

Click Add applications and complete the fields:

= Application Name — Enter Acumen.

= Redirect URL — Enter https://lwww.deltek.com.

7. Click Done.

The Acumen Client ID, Client Secret, and Redirect URL are listed on the tab.

8. Copy and paste each field entry into the corresponding field in Acumen (File » Deltek
Acumen Options » Platforms tab), or email the information to another user.

RiskBook 3
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Enable RiskBook in Acumen

Enable RiskBook in Acumen

When you purchase a RiskBook license, Acumen should automatically be set up to publish a risk
register to RiskBook. If the Publish Risk Register to RiskBook icon on the S3 // Risk tab is
grayed out, you may need to manually enable RiskBook.

To manually enable RiskBook, complete the following steps:

1.
2.

In Acumen, click -f:j‘ File » Deltek Acumen Options.

On the Platforms tab, in the Kona by Deltek group, complete the following fields (this set
of fields is known as the Kona Business Token):

= Redirect URL
= (Client ID
= Client Secret

If you do not know the Kona Business token information that needs to be entered,
please contact your Kona Business Administrator or Kona Support

(support@kona.com), or you can log a case at: http://support.kona.com/tickets/new.

Click OK to save the information and close the dialog box.

RiskBook
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Publish a Risk Register to RiskBook

In order to publish a risk register to RiskBook, you need to be a member of the Kona Business
Account.

If you do not have a Kona account, contact your administrator, or Kona Support
at support@kona.com, to request that they add you to the Kona Business Account. An emalil
will then be sent to you with details about setting up your account.

To publish arisk register to RiskBook, complete the following steps:
1. Onthe S3// Risk tab, use the risk register to create your risk events.

If you enter an email in the risk register Owner Email column, and the user is a member
of your Kona Business account, then when the risk register is published to RiskBook, the
user will get an email inviting them to the space.

See Risk Register in the Acumen User Guide for more information.
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2. Click Risk Register » Publish Risk Register to RiskBook.

If this option is grayed out, see Enable RiskBook for more information.

3. Do one of the following:

a. If you have set up a RiskBook space before, skip to step 4.

If you have changed your password, you will need to re-authenticate by
following the directions in Step 3b below.
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Publish a Risk Register to RiskBook

b. If this is your first time setting up a RiskBook space, or if you have changed your
password:

i. Onthe Kona Log In screen, enter your Kona login details.

account for the first time, click the question mark icon to display the

‘ If you are a Kona Business Account administrator logging into your
reset password screen where you can set up your own password.

43 ¥oma | Log in

[ESmEY =)

fova

Aloha! Welcome back.

| [ |

ii. Click Log In.

iii. On the Kona Integrate Risk Register screen, click Yes, Grant Access to
allow Risk Register to access your Kona account.

0 fomltenn =)

ova

Integrate Risk Register

Susan Minne, Risk Register s asking far secess to your Kona Account We naed 1o
maka sure you ara OK with this.

mREY

Mo thanks. Return lo Risk Regisier

[

You only need to perform this login step the first time you access RiskBook or if

you change your password. Acumen retains your Kona login information so that,
when you create another RiskBook space, you won't need to enter your login
details or grant access to Kona again.

RiskBook
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4. On the Create an Acumen RiskBook Register screen, complete the fields.
F
£} Create an Acumen RiskBook Regist-‘er. b w&g
. Create an Acumen RiskBook Register
Space Name
| City Center Office Building Addition |
Description
| Project to add additional office space to PEM office building |
Owverview
This project adds 50% more space to the PBM office building. That includes 12 offices, a training room, 3
meeting rocms, and a kitchen.l
Account
| Deltek -
Opticnal Template
| ok || Cancel |
————— E 3
= Space Name — The name of your RiskBook space.
= Description — A description of the space.
= Overview — Use this field to describe the purpose for the space.
= Account — If you have more than one Kona account, select the account that Kona
should use when creating the space.
= Optional Template — If you have set up Kona templates, use this field to select a
template to apply to the space. If this field is blank, then no template is applied.
5. Click OK.
Kona opens a browser window or a browser tab (depending on your browser settings)
and creates the space.
City Center Office Building Addition /
|
"“I‘j_‘ m OVERVIEW CE\' CONVERSATIONS I l | RISKS \/ TASKS D EVENTS D FILES
oz ANNOUNCEMENLS - scsmounssmant
Welcome to the City Center Office Building SPACE SUMMARY
Addition Space. ) »
Project to add additional office space to PEM
frops office building
1 Active Conversations A Comer o
0 tasks
0 events
City Center Office Building... 0iiles
Eveyeil) 1 person
Seeall
RiskBook 7
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7. The Risks tab lists all the risks from the published risk register.

City Center Office Building Addition #

‘m OVERVIEW (:C} CONVERSATIONS ||||l msks (V) Tasks D EVENTS D FILES

| Adda risk
+ Add folder ALL Tags: Add filter u':_% Manual
All risks (2) @ Hurricane

Stari organizing risks to help find, sort, and 1 person | ¥ scored [l 18 {-You scored
manage the things that need o get done. @ New Hires

1 person | 1scored Il 25 | You scored

(1) Training
1person | 1scored & You scored
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Using RiskBook

Using RiskBook

After you create the RiskBook space, you can invite people to the space to start conversations
and get input on the risk register.

Open arisk to:
= View details about the risk register owner’s threat analysis score.
= View or add comments.
= View consensus results, including a breakdown for each category.
= Add your own threat analysis scores.

= View the risk matrix that the risk register owner set up.

—
l 1 Threat analysis 1 of 1 responded I Hurricane ]
Show results E () Space: City Centel
D 9 Assigned to: Susal
Susan M pisk Matrix 5
Crestor . "
& e Low Medium  High eny
Probability High { Low High
Schedule impact | Very High  =75% —
(D Costimpact High High ~50% “ “
+ Add mitigation Medium =25% —n %‘
e Low Sl : | ¢ | 5 | ¢ | £
- 2
. Impact
Probability p
| High - (> 50%) —

Example of a RiskBook Risk

2 |~ i bt dnabrien 1 rengondod Humicane "
Annigrsd b, Soat Mirw Fileh: ped Bl el e Y
igs : |
2 View risk matrix |
|
View consensus d
PRI results | ~—lericl
g (0 s 150 et b s Y
et ihpact Add threat analysis ﬁ
i - 5,000/006 by 30,806,006 - 4
scores /
Rpace MemDers [
. . Lt Ll
Export risk register
to XML file
| Baan Mine: &
&
T8F 8iuy
Siom
) s [ anc | (D
o a"
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Export Risk Register from RiskBook

Export Risk Register from RiskBook

After everyone has provided feedback, you can export the risk register to an XML file which can
then be imported back into Acumen.

To export the risk register from RiskBook, complete the following steps:

1. In RiskBook, click Export risk data.

You must be in a specific space to export. You cannot export from My Kona as that is
a cross space/project area.

The export may take several minutes to complete. When complete, the number on
your Kona notifications icon will increase by 1.

The exported risk register is attached to the RiskBook space as a spreadsheet file. The
file name is the same as the risk register Kona space name.

2. Use the Files tab to open or download the file.

RiskBook
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Import Risk Register Back Into Acumen

Import Risk Register Back Into Acumen

To import the risk register back into Acumen, use the Microsoft Excel import function in the Get
External Data From group on the S1 // Projects tab.

RiskBook 11
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Appendix A: Kona Business for the Administrator

Getting Started
My Kona is your personal view in Kona. It includes your:
= Conversations
= Tasks
= Events
= Reminder pad

You can get back to this view anytime by clicking on the Kona logo in the top left hand corner.

KOV[Q [ =) % “ Grace Gooper (7]

@couvsasmmns v Tasks EVENTS D FILES ooy

Schedule site visit

ES UNREAD MUTEL
Task due
Unread Conversations | W First Parformance Review

oA %ubeonsut‘%ar:.t Overwev.\.I Q) vou were mentioned Schedule doctor's appt

Review Images

Codelco Client Meeting €3 Loty o

Interview with CureSearch Org
Read Conversations

Follow-up
W Mirage BLDG Contract
| WusToOMPLETE |

Check on decision
(@ Decision: City Permit Cha

Library books

Kona Area Description

Spaces lists all the spaces for which you are a member.

D|U_—:| Spaces (29)
Manage | Add Join . . .
| A space is a private place where a group of people, with a common

I ' purpose or goal, can collaborate.

People lists all the people with whom you are connected through
Kona, both inside and outside your organization.

; People (36) | 1 display certain people at the top of the list, click Manage then click

Mansge the Favorite star next to their name. You can “favorite” up to 15
people.
— The Kona Business Administrator uses Accounts to manage account
smm Accounts (1) | users and client applications (integrations with Kona), and view usage
reports.
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’l Managing Accounts

Make it r
those

able for

Account type: Pariner
1000 members

File storage limit: 20 GB
Lj 0% used

Boost Productivity!

Add the power of Konato
other applications.

Manage client applications

Kona Dot Com

kona.com

It's Konal

The default space for this account is The Hub where everyone in the Kona Dot Com
account can communicate with the entire organization as a whole.

2 » *3
13 2 25

members administrators spaces
Add members

2 gpace publishers

Add administrators Add a space

24| Get account reports

Accounts Area | Description

Members

These are the people you have added to your Kona Business account.

Administrators

These are members who can add or remove people from your Kona
Business account. In addition, they can see the names of all spaces;
however, they can only see space details (for example, conversations)
where they are included as a space member and have permissions to
those space objects.

Spaces

These are all the spaces that have been created within your Kona
Business Account.

Space Publishers

These are members who have been given the ability to create space
templates.

Get account reports

These are usage reports that provide some visibility into which
members and spaces are most active and who is most leveraging your
Kona Business subscription.

RiskBook
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Appendix A: Kona Business for the Administrator

’ The “Getting Started with Kona Business” Space

This space is created for your initial Kona Business Admin and is designed to help you get started
with your Kona Business subscription.

Getting Started with Kona Business ~

m OVERVIEW CONVERSATIONS v TASKS | EVENTS D FILES

ANNouNcCemMents . assmouncenent

Be sure to check out the tasks tab in this SPACE SUMMARY
space, it is filled with lots of information to help This is the Getting Started with Kona Business

get you started! Space. This space has lots of great information

Jec 06 2013 09:58 AM in the tasks area organized into three sections:
Kona Overview, Best Practices and the Rollout
Checklist.

The Tasks tab includes the following information:

= Collateral to Share — This section includes a link to the Kona Business video, Kona
overview slide deck, Common questions and more.

= Best Practices — This section includes to-do’s such as subscribing to the business
edition updates, tips on getting your first space going, and how to lead through this
transition.

= Kona Admin Checklist — This section outlines everything you need to get your
organization up and running in Kona.
Include Others in this Space

Click Invite under Space Members in the right margin area of the space to add others involved in
your Kona Business roll-out to this space.
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